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EMC Standard, EN 61326-1: 2006, Electrical Equipment for Measurement, Control and 
Laboratory Use. 

	 Emissions Class A, Commercial Equipment. 
	 Immunity Table 2, Industrial Equipment. 
LVD Standards, EN 61010-1: 2010, Safety Requirements for Electrical Equipment for 

Measurement, Control and Laboratory Use and;  
	 EN 61010-2-030: Particular Requirements for Testing and Measuring Circuits. 
speedy is an industrial controller designed for permanent installation by qualified 

professionals. If  it is used in a manner not specified herein the protection provided may be 
impaired. 

speedy and its packaging contain recyclable materials. 
This device complies with Part 15 of  the FCC Rules. Operation is subject to the following two 

conditions: (1)This device may not cause harmful interference, and (2)this device must 
accept any interference received, including interference that may cause undesired operation. 

This Class [A] digital apparatus complies with Canadian ICES-003.  Cet appareil numerique 
de la classe [A] est conforme à la norme NMB-003 du Canada. 

Warning! It is essential that you read and understand this entire manual and the entire 
contents of  the savvy software Help menu before proceeding with your installation and 
configuration. See page 7 for savvy installation instructions. For more information and to 
download manuals and software, go to www.driveweb.com or contact us. See page 20. 

Warning! Your use of  savvy software and drive.web devices may cause motors and 
machinery to power up with high Voltages or start or operate in an unexpected, dangerous or 
lethal way. It is essential that you are completely familiar with all of  the equipment and the 
system design before attempting to program or edit a program or connect to any live device. It 
is also essential that a risk assessment is conducted to identify hazards. Risks must be reduced 
to tolerable levels. 

Warning! You are entirely responsible for the configuration or use of  any drive.web 
product. By configuring or using these products you agree to indemnify and hold harmless 
Bardac Corporation, its’ employees, directors, officers, distributors and resellers against the 
consequences of  your configuration or use of  the products. 

Warning! Information in this manual is subject to change without notice. You are 
responsible for verifying the proper operation of  your speedy module. Special care must be 
taken after loading new firmware or installing new options.!

Warning! Avoid permanent damage to your speedy, never exceed any min or max 
values.  Do not connect any speedy terminal to mains circuits. See page 4 for details.  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lwIP is incorporated into speedy firmware. lwIP Copyright (c) 2001-2004 Swedish Institute of  Computer Science. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 
1. Redistributions of  source code must retain the above copyright notice, this list of  conditions and the following disclaimer. 
2. Redistributions in binary form must reproduce the above copyright notice, this list of  conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. 
3. The name of  the author may not be used to endorse or promote products derived from this software without specific prior written permission. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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Product identification, speedy model number!
speedy is a programmable device using drive.web 

distributed control over Ethernet for industrial 
process automation. To program and use a speedy 
you must get the savvy software tools from 
www.driveweb.com. Please see pages 7 to 11. 

To find the speedy‘s firmware version, launch savvy 
and choose Get Detailed Info from the speedy 
contextual menu. See page 11.  

dw221 is for PL/X-Series Digital DC drives with 
firmware version 6.12 or higher, only. 

speedy standard features 
drive.web distributed process control. 
10/100Base-T(X) Ethernet, page 6. 
Update firmware with savvy software. 
Promotes PL/X drive control software updates. 
Fitted onto the PL/X control board. 
Basic Control Function Block Library.  

speedy options  
Software options may be added using savvy. See page 12. 
See savvy User Manual for up-to-date function block listings. 
04 ModbusTCP/IP Slave/server. See page 18. 
05 Process Control Recommended for most applications. 
06 Winder Control See page 19. 
10 Math with internal 32-bit Calculator.  
25 EIP/PCCC Slave/server. See page 18. 
26 savvyPanel Operator station interface. See pages 13-17 
29 Solar With sun position azimuth and zenith. 
36 Motion Control With Trapezoid Motion and Cam Profile. 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speedy Stock Controllers 
Standard option packs are ordered with four-digit model 

number suffix. 
 -1121 Smart Systems Controller includes -04-05-25-26, 

Process Control l ibrary and Ethernet servers; 
ModbusTCP, EIP/PCCC, and savvyPanel. 

 -1122 Smart Systems Winders and Motion includes 
-04-05-06-25-26-36, adds Winder and Motion Control 
libraries to -1121. 

 speedy apps Engineered Solutions 
Generic engineered solutions include required options (in 

parentheses), system configuration, and wiring diagram. 
Contact us for many other engineered solutions. 
Compatible options may be added.  

-1101 Open-loop constant tension center winder (05, 06) 
-1102 Closed-loop dancer control center winder (05, 06) 
-1103 Closed-loop loadcell control center winder (05, 06) 
-1106 Coordinated drive, line master controller (05) 

speedy Installation!
Environment: UL/IEC Pollution Degree 2,  

Temperature, Operating, 0°C to 50°C. Storage, -20°C to 60°C.  
Altitude 3000m max. 
Humidity 95% max. non-condensing.  

Ethernet: MDI 8P8C, “RJ45” jack, 100baseTX, 10BaseT, Full 
Duplex, Auto-Negotiation, Auto-MDIX, IEEE 802.3ab.  

USB port  Peripheral-type Micro-B jack. 
Ethernet LEDs For setup, troubleshooting and monitoring: 

100 Green LED indicates 100BaseTX Ethernet connection. 
Link / Activity Yellow LED. On for Link, flashing for activity.  

speedy HG503208Iss1.1	  www.driveweb.com        Page # /204

http://www.driveweb.com


drive.web automation

speedy Installation Procedure 
Warning! Risk of  electric shock resulting in injury or death!  
PL/X drive is powered from more than one source of  high-
Voltage electricity.   
Only qualified personnel should proceed with installation!  
Risk of  damage to equipment if  installed improperly! 

1.Ensure all electricity sources are removed and isolated. 
2.Ensure that you and the equipment are grounded with 

ESD control equipment. 
3.Loosen the thumb screws and remove the upper 

and lower terminal covers. 
4.Locate and remove the four Philips head screws 

that hold the PL/X display-keypad-cover 
assembly in place. A long-shank #2 Philips 
head screwdriver is recommended. 

5.Gently lift the cover and display assembly and 
rotate it upwards and away from the drive. 
Support the assembly above the drive so that you 
do not strain the two ribbon cables. 

6.dw221 locates at the lower left corner of  the PL/X 
control board. 

7.Remove the nylon screw at the lower-left corner of  the 
PL-series control circuit.   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Do not remove 
this screw.

PL/X control board with 
dw221 installed. 

(Display assembly removed.)
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speedy Installation Procedure continued... 
8.Carefully install dw221, using the rear clip-pillar as a 

guide, while ensuring that the 6 pins on the PL/X 
control board are inserted into dw221's connector. !!!!!!!

9.Double-check the 6 connector pins are properly aligned 
and inserted! Misalignment may cause permanent 
damage! 

10.Thread the nylon screw into the PL/X control board 
mounting hole, and tighten. This is the lower-left hole 
that was revealed in step 7. above. 

11.Re-install the PL/X display-keypad-cover assembly and 
the four attachment screws. 

Set up your computer - get savvy 
With free drive.web savvy software, easily program and 

monitor speedy, perform data trending, and create 
distributed control systems. 

To download the latest version of  savvy, go to 
www.driveweb.com and click on get savvy. 

Java Runtime Environment must be installed to run 
savvy. There is a link on the get savvy page to 
download Java for free.  

If  you do not have internet access, install savvy and 
Java from the Bardac Infodisk. Browse to the 
savvy link, off-line installation. Contact us for the 
files or Infodisk. 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dw221 Installed. Viewed from left 
side of drive. (Drive chassis not shown.)

6-pin 
connector

Rear clip-pillar
PL/X control board 
and screen board

PL/X control board, 
lower-left  nylon screw 
removed and replaced.
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speedy USB - plug and play 

Experience plug-and-play access to speedy and its local 
Ethernet network. Requires 0x201A firmware or 
later. When using WinXP or other obsolete operating 
systems, contact us for details before plugging-in to 
USB. 

Some savvy functions are not available via USB. You can 
not change IP addresses, or other network settings. 

speedy Ethernet networking & programming 

Before proceeding, it is important to have a basic 
understanding of  Ethernet TCP/IP networks. 
Assigning an invalid or duplicate IP address will cause 
serious network malfunctions!  

Find useful networking information. Under the Help 
menu click on Getting Started with savvy section.  

speedys are all shipped with the same IP address, 
10.189.189.189. Consult your company’s IT 
department for an appropriate, unique IP address. 

Ethernet Network Requirements 

A standard Category 5e cable with 8P8C/RJ-45 
connectors on both ends for each drive.web  device 
and the host computer. 

For systems with more than one drive.web device, an 
Ethernet switch with ports for all drive.web devices 
and your computer.  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Get started with savvy 
We strongly recommend attending our free on-line 

training seminars. To register and get your invitation, 
call or e-mail training@driveweb.com. 

Before proceeding with your systems designs it is very 
important to familiarize yourself  with savvy, the 
configuration software.  

We strongly recommend you read the User Manual 
and Getting Started Guides under the Help menu.    

Use Create Phantom in the Directory menu to 
practice, explore all drive.web products and options 
and design and configure off-line. Design systems in 
Phantom devices and Export Data under the 
Directory menu for later use in live devices. Import 
Data into  phantoms to work off-line.  

savvy Window Title Bar indicates the current view. 

Status Bar, above the viewing area, provides 
Navigation Arrows and object and location data. 

savvy views are hierarchical with the Device 
Directory View at top. Use the Navigation 
Arrows to view the next higher level or go backward 
and forward through views. Note that window menus 
change as you navigate.  

Hover cursor over active object, device, function 
block, connection, or parameter icon to view object 
information in the Status Bar and reveal a Hover 
Button. 

Click a Hover Button or right-click an active object 
to access a Contextual Menu. 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Get started with savvy continued... 

savvy functionality may be limited if  you do not 
have the required password-protected capability level 
(see File > Capability...) or a device is locked with a 
password (see contextual menu below). 

Device Directory Window  

Warning! Changing a device IP address WILL disrupt its 
network connections! If  a speedy is communicating 
with other devices or drives you must be prepared for 
system disruption and to remap connections in those 
devices when changing an IP address. In the File 
menu choose Utility > Remap Export File to 
remap a dw-system file with different IP address(es). 

Select File > Administrate > Set IP Addresses 
for System.   

The serial number marked on the speedy and it 
packaging is its MAC Address.  

Enter a unique IP address within your computer’s 
subnetwork, click OK.   

A PL-Series icon should appear with IP address 
beneath. The graphic depicts the actual frame size of  
the drive. 

If  the icon at right appears, a network connection 
problem exists. Check connections, LEDs, and that 
the speedy  IP address is within your computer’s 
Ethernet subnet mask.   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Get started with savvy continued... 

Device Directory Window - Directory Menu.  !

Discover via USB... Perform basic operations without 
needing to configure your computer’s Ethernet port. 

Discover by IP Address... Anywhere on the internet, 
locally or  via a public IP address, VPN or similar.  

Warning! Importing a configuration into your speedy 
will result in immediate execution of  that 
configuration. Dangerous Voltages and rotating 
machinery may result! Use a phantom to preview 
a configuration. 

Import / Export Data. All device configurations 
and drive.web connections between devices in 
the directory. All in one dw-system file.  

speedy Icon Contextual Menu  

Change Name. Name your speedy for easy 
identification.  

Import / Export Device Data... Load / save 
configuration data to / from this speedy only. 

Find Parameter... Enter parameter number, name, or 
partial name to view it. 

Unlock, Lock, Set Password. The speedy at top-
right is locked to Restrict Modification. Viewing 
configuration is possible. The speedy below it is 
locked to Restrict All Access. Select lock type when 
setting password. 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Get started with savvy continued... 

Click the speedy icon to view the Device Overview 
(Standard savvy, no SFD). Find the Function 
Block Engine icon and, if  options 04 or 25 are 
present, the Comms Server icon, at top-right.  

Function Block Engine Window - FBE Menu 
(Standard savvy, no SFD),  

Add function blocks in the order to be processed. 
Processing order is left to right, top to bottom. 

Click function blocks to view parameters and details.  

Connect between parameters and to parameters in 
other drive.web devices over Ethernet.  

Warning! Making a connection results in immediate 
execution of  that connection. Dangerous Voltages 
and rotating machinery may result!. 

Under the File menu, choose New Viewer... and 
then, File > Open Device Directory.  

With two viewer windows, click on a parameter, 
drag a connection, and drop onto a 
destination parameter in the other viewer.    

Parameter Contextual Menu!
Most parameter data is 16-bit. Raw decimal integer 

values 0 to 65535 or ±32767. Data is formatted, 
limited, and scaled depending on the parameter.  Use 
Get Info or Re-Scale... to verify or change. 

Click parameters for the Setter Box Adjust value 
with convenient graphical buttons or keyboard entry. 
Also find buttons for return to default or last state. 

Click blue connection block or arrow to jump to 
other end. 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Upgrade savvy and speedy 
Upgrade savvy with SFD Signal Flow Diagram.  
Upgrade speedy with software options.  
Process credit cards or Vouchers on-line or Coupons off-line.  

To upgrade savvy go to the Commerce menu, select 
Upgrade savvy, check desired options, click OK. 

To upgrade speedy, choose Upgrade Device… in its 
contextual menu, check desired options, click OK. 

Your selected options will appear in the Shopping Cart. 
Select your method of  payment. 

To process Vouchers, choose Pay>Online Via 
Vouchers in the Shopping Cart. Enter 
Voucher codes on separate lines. 

To process Coupons click Buy and forward the 
code to your drive.web distributor. When you 
receive your coupons go to the Commerce 
menu and choose Coupon Manager. Enter 
codes in the top box and click the Add button. 
Click Apply. 

savvy-SFD Signal Flow Diagram Upgrade 
With savvy-SFD, build systems graphically. The live 

drawings are stored in your speedy.   
Set drawing borders and annotate multi-page drawings.  
A filterable list of  function blocks and connections is at 

the left of  the Signal Flow Diagram showing 
program execution order from top down. The 
order in which function blocks are processed can 
greatly influence system performance and the 
function of  logic engines.  
Change execution order by dragging function blocks 

up or down the list. In this picture, ENC1 Speed 
function block and its outgoing connection will be 
moved so that they are processed after ENC 
Phase Lock. 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savvyPanel Operator Station!
Computers, Apple® mobile digital devices; iPad®, 

iPhone®, and iPod Touch® are operator touch 
stations with savvyPanel. Requires Windows(XP, 
Vista, 7), Mac OS X, Linux-based Ubuntu, or iOS®. 

Operator station configurations are stored in 
the drive.web devices. 

Editing and building savvyPanel systems 
requires savvy-SFD upgrade. 

dwOption-26 savvyPanel, must be 
installed in drive.web devices to enable 
the full suite of  tiles. A limited set is 
available without the option.  

Find complete information on savvyPanel 
in the savvy User Manual. 

Get savvyPanel free from the Apple App Store℠!
When your iPad or iPhone is connected to the internet 

via WiFi, Demo Mode connects to a live drive system 
in our plant in Maryland, USA. 

Touch Roll Change button to reset the roll length. 
Enable all section switches; extruder, brake, winder, 
Touch the Line Start button and watch the line 

accelerate, run, and then automatically slow to stop 
at the required length. 

Touch Set Speed, Set Temp or Set Tension to open 
the setter and make changes. 

Touch the parameter name in the setter to get info 
Touch page-link arrows to browse demo pages. 
Explore the demo with savvy on your computer. In the 

File menu, choose Demo Mode > Discover 
Internet Demo Devices. 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savvyPanel Pages!
Systems Page is available when multiple savvyPanel 

systems are discovered.  
Each savvyPanel system may contain tiles from 

many drive.web devices.  
Each drive.web device may contribute to only one 

savvyPanel system. 
Touch the systems button,     or     , in the window bar 

to access the systems page from home page. Lock this 
button with home password. 

Home Page is the first operator page in a savvyPanel 
System. 

Access home page from any operator page with the 
home button,      . Lock with the home password. 

Operator Pages show graphic, page-link, and 
parameter tiles.  

Pages can be renamed. The name appears in the 
window title bar. 

savvyPanel Tiles!
Parameter Tiles Touch a settable parameter to see its 

savvyPanel Setter. Includes slider, keypad, 1x, 10x 
increment, default, and revert.  

A parameter is settable if  it is not read-only and has no 
incoming drive.web connection. 
Meter Digital panel meter, dial, or bar meter. 

Unipolar, bipolar, full-scale, and percent choices. 
Indicator Variety of  colors. Shows on/off, true/false  

boolean state. All non-zero values are true. 
Pushbutton Momentary actuators in a variety of  

colors, also lighted Start/Stop. 
Multi-position Switch For enumerated parameters.  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!
savvyPanel System 
Example !!

Discover devices when savvy 
launches or by using the 
Directory menu. Discover by;  
group, savvyPanel system, 
Discovery file, or all local 
devices automatically.

Device Directory

Function Block Engine
With standard savvy, the device 
overview screen gives access to 
Comms Server setup, Function 
Block Engine, and native device 
functions where applicable.  
With savvy-SFD place function 
blocks graphically. Use function 
block list to review and arrange 
execution order.

Function Block
View functional elements and 
signal paths in relation to 
parameters. Parameters show 
type, drive.web connections, 
read-only and not at default 
adornments.  

Add parameters of  interest to set, 
view, create trend graphs, and 
export .csv files for spreadsheets. 
Save docks and open multiple 
docks in different viewer 
windows.

Parameter Dock

Navigate 
Up 

Arrow

savvy overview
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Systems Page
View all available 
savvyPanel systems.  
Assign a savvyPanel system 
in each device’s contextual 
menu, one per device.  
If  a savvyPanel password is 
set in the device, it must also 
be added in savvyPanel 
operator station software.

Home Page
The first page in a 
savvyPanel system.  
Similar to Operator Pages 
except that it may be accessed 
from any Operator Page by 
pressing the Home button. 
Touch page-link tiles to go to 
Operator Pages.

Up to 256 possible. May be 
page-linked in any way.  
Set savvy preferences so 
that operators view a specific 
page at launch. Restrict 
access to the Home Page and 
pages linked only from the 
Home Page with the Home 
Password. Provide links to the 
home page to bypass the 
home password.  
A page-link to the Home 
Page bypasses the Home 
Password.

Operator Pages

Systems Button.  
Requires Home Password if  set.

Home Button.  
Requires Home Password if  set.

savvyPanel overview
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savvyPanel Tiles continued...!
Graphic Tiles Create diagrams with a variety of  process 

elements. 
Page-Link Tiles A graphic tile that is also a page-link.  

Touch to change the view to that page.!
Device Tiles Link to device’s signal flow diagram in Java-

based savvyPanel. Appears as graphic tile in iOS.!
Function blocks enable savvyPanel actions!
Alarm Annunciator Provides a system-wide alarm 

annunciation when active. Touch to view page 255. 
Presence Monitor Indicates the presence of  a tagged 

savvyPanel application viewing a particular page. 
Latch and SR Latch support lighted start-stop 

pushbuttons.  
Setpoint & Monitor blocks control meter range. 

Setpoint clamps setter. Dual blocks enable dual-
display meters 

Enumerated Parameter block in Utility group. Only 
custom enumerations appear in the setter and multi-
position switch. 

savvyPanel launch, setup and important notes!
See the savvy user manual for detailed instructions. 
Launch savvyPanel via command line or batch file.  
Limit operators to savvyPanel only. Specify start 

system and page. 
Discover devices automatically, specifically by discovery 

file, or filtered by group and/or savvyPanel name. 
Operator’s note: If  communication with a drive.web 

device is interrupted, affected tiles indicate a yellow 
bar at top with an exclamation warning. The 
displayed value is not updated. 

Important Design Note An over-range enumeration is 
required if  misreading an out-of-range value could 
cause a hazard.  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speedy Ethernet Server Options 04 & 25!
Warning! Use of  speedy options 04 and 25 may cause motors and 

machinery to energize with high Voltages or start or operate in 
unexpected, dangerous, or lethal ways. It is essential that you are 
completely familiar with the Ethernet server protocol, equipment, 
and the system design before use of  these options. It is also 
essential that a risk assessment is conducted to identify hazards 
and that risks are reduced to tolerable levels.  

Note! You cannot write or force parameters that are 
read-only or have incoming drive.web connections. 

Comms Server Indirect parameters are 
sequential ly numbered. Enter any 
parameter numbers to read or write them 
with one operation. Click the Comms 
Server button or add more sequential 
parameters with Comms Server Indirect 
function blocks in the Utility list set. You 
can directly address any numbered 
parameter in your function block engine. 
You are NOT required to use Indirect 
parameters. 

speedy Option 04 ModbusTCP/IP Slave/Server!
For Modbus specs go to http://modbus.org/specs.php 
ModbusTCP Slave Port 502 is the standard specified 

in the protocol. You may change this to match the 
master in the unusual case that it is non-standard. 

Supported Modbus Function Codes; 1 thru 6, 15, and 16. 
Supports up to five simultaneous clients/masters.  

speedy Option 25 EIP/PCCC Server!
Supports PLC5 Typed-Write and Typed-Read commands. 
See Appendix B of  the savvy User Manual for 

information and drive.web parameter IDs mapping 
to PLC5 file numbers and register addresses. 

Supports up to two simultaneous clients.  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speedy Option 06 Winder Control Library!
Accurate speed calibration is essential for commissioning. 
Diameter Calculator Associate in Taper Tension 

and Torque Compensator blocks.  
Taper Tension Change web tension as diameter changes.  
Torque Compensator Block Set Forward/Reverse 

friction compensation, Unwind/Rewind modes.  !
speedy Option 36 Motion Control Library!
Trapezoid Motion Block Set accel and decel rates, 

max speed, nominal time, and tuning. Provides 
optimal speed setpoints to move to the setpoint. 

Cam Profile Block Graphic cam editor in which Y-
axis represents the Output value for any X-axis 
Input value. 

2-Axis Closed-Loop Position w/ Touch-Control Example!
Requires dwOptions-05-26-36, Process and Motion 

Control libraries, and savvyPanel. 
Moves are controlled by a single savvyPanel 

position setter. The second axis follows a cam 
profile of  the main axis with an additional 
savvyPanel trim.  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Main Drive 
Setpoint 
Output

Cam Drive 
Setpoint 
Output

savvyPanel 
Position

savvyPanel 
Cam Trim

Main Axis 
Position Input

Cam Axis 
Position Input
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drive.web Product Line Highlights 
Drive-dedicated smarty   and speedy models: 

smarty DIN rail drive.web controller.   

Sixteen flexible, bipolar-analog / digital I/O 

Options; serial-ports, +six digital inputs, freq. I/O, dual 
stepper, dual encoders with line shaft, 115VAC I/O 

savvyPanel Touch Hi-resolution, 
drive.web operator panel.   

Model dw230 is 7” diagonal. 

savvy-SFD Signal Flow Diagram, pg. 12. 

savvyPanel operator panel app, pgs. 13-17. 

drive.web products are designed & assembled in the USA. 

Get drive.web help. Call or Email techsupport@driveweb.com 

drive.web training courses  

Free online interactive training seminars take about one hour.  

Specialized online and factory training sessions are also available.  

To register email training@driveweb.com or call.

Supported Drive smarty  Model speedy  Model
Generic dw210 dw220
PL/X Digital DC Drive dw211 dw221
Optidrive P2 dw214 dw224
Optidrive Plus dw213 dw223
Optidrive HVAC dw216 dw226
Optidrive E2 dw212 dw222
Optidrive E2 Single Phase Output dw212 dw222
YaskawaF7 dw215 dw225
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